




 

 

For Detailed information go to the Help Menu in Adobe Acrobat. 
  
Opening PDF documents 
The documents on this site open with page one and Bookmarks opened on the left pane for easy 
navigating to whatever page you would like to view. 
  
We do not default to Full Screen View, however if a document is set to open in Full Screen view, 
the tool bar, menu bar, and window controls are not visible. You can exit Full Screen view by 
pressing Escape, if your preferences are set this way, or by pressing Ctrl+L (Microsoft® 
Windows® and UNIX®) or Command+L (Mac OS).  
  

Viewing PDF documents on the Web 
With most of the files at this site, you can view PDF documents using a Web browser. Every 
document on the Web is identified by a (URL). When a PDF document is stored on the Web, you 
can click a URL link to it to open the PDF document in your 
Web browser.  This is the preferred method. 
  

Reading PDF documents in a Web browser 
  
In Win and Mac OS, PDF documents are displayed in the Web browsers compatible with 
Netscape Navigator 4.0 (or later) or Microsoft Internet Explorer 4.0 (or later).  
  
Normally the necessary plug-ins are automatically installed when you install Acrobat Reader. For 
information on manually getting your browser ready, see Installing the Web browser plug-in.  
  
(NOTE:  If pages of your PDF document appear blank when viewed in a Web browser, you may 
be using an early version of a Web server. Try saving the PDF file locally, and viewing it using 
Acrobat Reader instead of the plugin.) 
  
When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available 
in the browser. In Windows, you can click the two small vertical lines (next to the Adobe icon at 
the left of the tool bar) to minimize or maximize the tool bar. 
  
Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat Reader, 
so some Acrobat Reader keyboard shortcuts may not be available in the browser window. 
  
In UNIX, PDF documents can display in Web browsers compatible with Netscape 
Navigator 4.0 (or later) only. To set up Netscape compatibility, launch Netscape using the 
Netscape script located in the Acrobat 4.0/Browsers directory. Follow the instructions in the 
INSTGUIDE.TXT file to link your Netscape browser to the Acrobat 4.0 Reader with Search 
application. 
  

Web viewing scenarios 
  
Here are four possible scenarios for viewing PDF on the Web.  We use Optimized PDF files to 
download a page-at-time This is when the browser supports PDF viewing, the PDF file is 
optimized, and the Web server supports page-at-a-time downloading (byte-serving), so the PDF 
file downloads a page at a time and displays the file pages in the Web browser window. This is 
the fastest scenario possible for viewing PDF documents on the Web. 



 

 

  
There are other downloading possibilities, which we do not use on this site. 
  
  

Page-at-a-time downloading 
  
With page-at-a-time downloading (byte-serving), the Web server sends only the requested 
page of information to the user, not the entire PDF document.   
For those who want the entire document, there are other methods used to download  the entire 
document to your hard disk.   
  
As a reader of the PDF document, you do not have to do anything to make this page-at-a-time 
happen; it is communicated in the background between Acrobat Reader and the Web server. If 
you want the entire PDF document to continue downloading 
in the background while you view the first page of requested information, be sure Allow 
Background Downloading is selected in the General preferences dialog box (default). 
  

If you wish to download the entire file to your computer, right click your mouse button, and then,  

Select: Save link as... If you use Netscape or, 

Select: Save target as... If you use Internet Explorer   

After you decide where on your computer you want the file, hit "SAVE" to 
download. Once the file is on your computer double click on it to open it in Acrobat 
Reader. With this method you can open these files from your computer at anytime. 

  

Reading PDF in a Web browser 
  
PDF documents can display in Web browsers compatible with Netscape Navigator 3.0 (or later) 
or Internet Explorer 3.0 (or later). The necessary plug-ins are automatically installed when you 
install Acrobat Reader.  
  
When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available 
in the browser. In Windows, you can click the two small vertical lines (next to the Adobe icon at 
the left of the toolbar) to minimize or maximize the toolbar. 
  
Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat Reader, 
so some Acrobat Reader keyboard shortcuts may not be available in the browser window. 
  

Installing the Web browser plug-in 
  
Browsers compatible with Netscape Navigator need the nppdf32.dll file (Windows), the nppdf.so 
file (UNIX), or PDFViewer plug-in (Mac OS) to display PDF.  
  



 

 

When you install Acrobat Reader with Search, this plug-in is automatically installed in the 
Netscape plug-in folder (Win and Mac OS), if you have Navigator on your system. If you install 
Navigator after installing Acrobat Reader, or if you’re using another browser compatible with 
Navigator, you can install this plug-in yourself. To set up Netscape Navigator on a UNIX system, 
you must run the Netscape launch script located in the Browser folder. 
  
To manually install the Web browser plug-in (Windows): 
1 Open the Browser folder in the Acrobat Reader folder. 
2 Copy the nppdf32.dll file to your Web browser’s plug-ins folder. 
  
To manually install the Web browser plug-in (Mac OS): 
1 Open the Web Browser Plug-in folder in the Acrobat Reader folder. 
2 Copy the PDFViewer plug-in to your Web browser’s plug-ins folder. 
 
To open a PDF document that’s been downloaded onto your system: 
  
Do one of the following: 
  
Click the Open button , or choose File > Open. In the Open dialog box, select the filename for 
the file downloaded on your computer, and click Open. PDF documents usually have the 
extension .pdf. 
  
You can also choose the document’s filename from the File menu for the last four PDF 
documents you opened.  You can also Double-click the file icon in your file system. 
  
Note: In Mac OS, you may not be able to open a PDF document created in Windows by double-
clicking the icon. If double-clicking the icon in Mac OS does not open the document, use File > 
Open in Acrobat Reader to open the document, close the document, and try again. After you’ve 
used the Open command once on the document, you’ll be able to open the document next time by 
double-clicking. 
  
To display a list of all Acrobat Reader command-line options (UNIX), start the Acrobat Reader 
product with the -help option. For example:  acroread -help 
   
To manually install the Web browser plug-in (UNIX): 
Run <installdir>/Browsers/netscape. 
  

Browsing with bookmarks 
Bookmarks mark parts of a document for quick access, link to page views in other documents, 
link to the Web, play a movie or sound, enter an article, or reset or submit a form.  Primarily we 
are concerned with the sheet music at present however as this develops more features will be 
incorporated.  Essentially Bookmarks are nothing more than links to open pages inside the 
document or files outside of the document. 
  
To browse with a bookmark: 
  
1 Show the Bookmarks palette (This is the default on first opening the music files. If not, you 
may need to choose Window > Show Bookmarks to open the palette or click the Bookmarks tab 
to bring the palette to the front of its group. 
  



 

 

2 To jump to a topic using its bookmark, click the bookmark’s icon or text in the palette. 
  
Note: Clicking a bookmark might perform an action, such as playing a movie, instead of taking 
you to another location. It depends on how the bookmark was defined. 
  
The bookmark for the part of the document currently showing appears boldfaced. If the 
navigation pane disappears when you click a bookmark, the document creator has activated the 
Hide After Use command. To show the navigation pane again, click the Show Navigation Pane 
button on the command bar. Deselect Hide After Use in the navigation pane’s palette menu if you 
want the navigation pane to remain open after you click a bookmark. 
  
Bookmarks can be subordinate to other bookmarks in their hierarchy; a higher-level bookmark in 
this relationship is the parent, and a lower-level bookmark is the child.   You open these and close 
these by selecting the (+) to open or (-) to close next to the bookmark listing if in Windows and 
the Triangle in the MacOS. 
  
  
In other words, you can collapse a parent bookmark in the palette to hide all its children. When a 
parent bookmark is collapsed, it has a plus sign (Windows) or a triangle (Mac OS) next to it. If 
the bookmark you want to click is hidden in a collapsed parent, click the plus sign or triangle next 
to the parent to show it. 
  

Paging through a document 
  
Acrobat Reader provides buttons, keyboard shortcuts, and menu commands for paging through 
PDF documents. 
  
To go to another page do one of the following: 
  
To go to the next page, click the Next Page button in the command bar or status bar, press the 
Right Arrow key, press Ctrl (Windows or UNIX) or Option (Mac OS) and the Down Arrow key, 
or choose Document > Next Page. 
  
To go to the previous page, click the Previous Page button in the command bar or status bar, 
press the Left Arrow key, press Ctrl (Windows or UNIX) or Option (Mac OS) and the Up Arrow 
key, or choose Document > Previous Page. 
  
To move down one line, press the Down Arrow key. 
To move up one line, press the Up Arrow key. 
  
Note: The Down and Up Arrow keys move you one line at a time when you are in Window view. 
In Single Page mode, these keys move you one page at a time if the page fills the entire screen. 
  
To move down one screen, press Page Down or Return. 
To move up one screen, press Page Up or Shift+Return. 
  
To go to the first page, click the First Page button in the command bar or status bar, press the 
Home key, or choose Document > First Page. 
  



 

 

To go to the last page, click the Last Page button in the command bar or the status bar, press the 
End key, or choose Document > Last Page. 
  
To jump to a page by its number: 
  
Do one of the following: 
  
Select the current page number in the status bar, type the page number to jump to, and press 
Return. 
  
Choose Document > Go To Page, type the page number, and click OK. 
  
OR 
  
Drag the vertical scroll bar until the number of the page you want to jump to is displayed. 
  
To retrace your viewing path: 
  
To retrace your path within a PDF document, click the Go to Previous Viewbutton in the 
command bar, or choose Document > Go Back for each step back. Or click the Go to Next View 
button, or choose Document > Go Forward for each step forward. 
  
To retrace your viewing path through other PDF documents, choose Document > Go Back Doc 
for each step back or Document > Go Forward Doc for each step forward. Or hold down Shift, 
and click the Go Back or Go Forward button. This command opens the other PDF documents if 
the documents are closed. 
  

Visiting the Adobe Web site For additional help: 
  
Click the Adobe Web Site button to link directly to the Adobe Web site (www.adobe.com). This 
page contains valuable information about new technology, links to Acrobat plug-ins, and more. 
On the Adobe Web site home page, you can click a country name in the Adobe Sites pop-up 
menu to choose a language for viewing the site. The exact information in the site may vary from 
one language version to another. 
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

8. Om  Sri
8. Om  Sri

5. Om  Sri
5. Om  Sri

10. Om  Sri
10. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

9. Om  Sri
9. Om  Sri

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

The English translation was authored by Rameesh and Ananda Kasturi of Puttaparthi in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.

(BHAGAVAN  SRI  SATHYA  SAI  BABA ASHTOTRA  SHATHANAAVALI)
A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

19. Om  Sri
19. Om  Sri

15. Om  Sri
15. Om  Sri

20. Om  Sri
20. Om  Sri

21. Om Sri Sai,
21. Om Sri Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

18. Om  Sri
18. Om  Sri

16. Om Sri Sai,
16. Om Sri Sai,

12. Om  Sri
12. Om  Sri

17. Om  Sri
17. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

Sai, You have manifested Yourself in the village Puttaparthi,
Sai, Parthi Gramodbhavaaya...................................................

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Mahesvara Svaroo.......................................................................

Na-ma-hah....
Na-ma-hah....

Bhaarad-
.............

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

(BHAGAVAN  SRI  SATHYA  SAI  BABA ASHTOTRA  SHATHANAAVALI)
A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
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24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

25. Om  Sri
25. Om  Sri

27. Om  Sri
27. Om  Sri

32. Om  Sri
32. Om  Sri

30. Om  Sri
30. Om  Sri

28. Om  Sri
28. Om  Sri

29. Om  Sri
29. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

31. Om Sri  Sai,
31. Om Sri  Sai,

You are the re-incarnation of Shirdi Sai
Shirdi Sai Moor........................................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

26. Om  Sri   Sai,

26. Om  Sri   Sai,

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................

(BHAGAVAN  SRI  SATHYA  SAI  BABA ASHTOTRA  SHATHANAAVALI)
A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
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36. Om   Sri    Sai,
36. Om   Sri    Sai,

37. Om  Sri
37. Om  Sri

35. Om  Sri
35. Om  Sri

40. Om  Sri
40. Om  Sri

33. Om  Sri
33. Om  Sri

38. Om  Sri
38. Om  Sri

39. Om  Sri
39. Om  Sri

34. Om  Sri
34. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

42.  Om   Sri
42.  Om   Sri

43.  Om   Sri
43.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................

You are the Embodiment
Anan-...............................

You are affectionately related to everyone in
Loka Baadha-..................................................

41. Om   Sri   Sai,
41. Om   Sri   Sai,

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya

(BHAGAVAN  SRI  SATHYA  SAI  BABA ASHTOTRA  SHATHANAAVALI)
A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
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Na - ma - hah.......
Na - ma - hah.......

47. Om  Sri
47. Om  Sri

50. Om  Sri
50. Om  Sri

48. Om  Sri
48. Om  Sri

52. Om  Sri
52. Om  Sri

49. Om  Sri
49. Om  Sri

51. Om   Sri    Sai,
51. Om   Sri    Sai,

53. Om  Sri
53. Om  Sri

54. Om  Sri
54. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

44. Om   Sri
44. Om   Sri

Na-ma-hah..
Na-ma-hah..

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

You are the Giver of Freedom and Liber-
Mukthi Pra-.............................................

46. Om  Sri  Sai,
46. Om  Sri  Sai,

You are the Giver of fruits of meritorious and be-ne-fi-
Punya Phala Pra-..........................................................

45. Om Sri

45. Om Sri

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                                 responsible for creation, preservation
Sa-i, Moor.................-.........................thi Thraya Svaroo...................-

  and de-..struc-tion,
.................paa - ya..

(BHAGAVAN  SRI  SATHYA  SAI  BABA ASHTOTRA  SHATHANAAVALI)
A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
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Na - ma - hah.......
Na - ma - hah.......

57. Om  Sri
57. Om  Sri

62. Om  Sri
62. Om  Sri

61. Om   Sri    Sai,
61. Om   Sri    Sai,

58. Om  Sri
58. Om  Sri

63. Om  Sri
63. Om  Sri

64. Om  Sri
64. Om  Sri

59. Om  Sri
59. Om  Sri

55. Om  Sri
55. Om  Sri

60. Om  Sri
60. Om  Sri

65. Om  Sri
65. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

56. Om  Sri  Sai,
56. Om  Sri  Sai,

You are the Very First Person, the One who was
Aadi Puru-..............................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye
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Na - ma - hah.......
Na - ma - hah.......

67. Om  Sri
67. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

74. Om  Sri
74. Om  Sri

70. Om  Sri
70. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om   Sri   Sai,
76. Om   Sri   Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are loved by all,
Sai, Priyaaya.................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

66. Om  Sri  Sai,
66. Om  Sri  Sai,

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

You are the Inspirer and Granter of Love in all
Prema Pra-..........................................................

You dwell in the hearts of the de-
Bhaktha Jana Hridayala-...........

You are the Embodiment of Supreme
Jnaana Svaroo-.................................

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

71. Om   Sri   Sai,
71. Om   Sri   Sai,
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Na - ma - hah.......
Na - ma - hah.......

81. Om   Sri   Sai,
81. Om   Sri   Sai,

77. Om  Sri
77. Om  Sri

82. Om  Sri
82. Om  Sri

87. Om  Sri
87. Om  Sri

78. Om  Sri
78. Om  Sri

83. Om  Sri
83. Om  Sri

79. Om  Sri
79. Om  Sri

84. Om  Sri
84. Om  Sri

80. Om  Sri
80. Om  Sri

85. Om  Sri
85. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

You bestow the fruits of all
Phala Pra-..........................

86. Om  Sri  Sai,
86. Om  Sri  Sai,

You are the Embodiment of Success, Prosperity and Per-
Siddhi Roo-........................................................................

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..
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Na - ma - hah.......
Na - ma - hah.......

91. Om   Sri   Sai,
91. Om   Sri   Sai,

92. Om  Sri
92. Om  Sri

97. Om  Sri
97. Om  Sri

88. Om  Sri
88. Om  Sri

93. Om  Sri
93. Om  Sri

98. Om  Sri
98. Om  Sri

89. Om  Sri
89. Om  Sri

94. Om  Sri
94. Om  Sri

90. Om  Sri
90. Om  Sri

95. Om  Sri
95. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

96. Om   Sri   Sai,
96. Om   Sri   Sai,

You are the Giver of all Desirable
Sarvaabheeshta Pra-....................

You purify the mind of Your de-
Saadhu Maanasa Parishodha-

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya
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101. Om   Sri   Sai,
101. Om   Sri   Sai,

102. Om  Sri
102. Om  Sri

103. Om  Sri
103. Om  Sri

99. Om  Sri
99. Om  Sri

104. Om  Sri
104. Om  Sri

100. Om  Sri
100. Om  Sri

105. Om  Sri
105. Om  Sri

106.
106.

107.
107.

108.
108.

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

You are revered by the masters of
Yogindra Vandi-..........................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

5. Om  Sri
5. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

12. Om  Sri
12. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

10. Om  Sri
10. Om  Sri

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

9. Om  Sri
9. Om  Sri

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

8. Om  Sri
8. Om  Sri

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

21. Om Sri Sai,
21. Om Sri Sai,

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

Bhaarad-
.............

Na-ma-hah....
Na-ma-hah....

19. Om  Sri
19. Om  Sri

20. Om  Sri
20. Om  Sri

18. Om  Sri
18. Om  Sri

17. Om  Sri
17. Om  Sri

16. Om  Sri
16. Om  Sri

15. Om  Sri
15. Om  Sri

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sai, You have manifested Yourself in the village Puttaparthi,
Sai, Parthi Gramodbhavaaya...................................................

Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Sai, Mahesvara Svaroo.......................................................................

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

26. Om  Sri   Sai,

26. Om  Sri   Sai,
...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

28. Om  Sri
28. Om  Sri

27. Om  Sri
27. Om  Sri

25. Om  Sri
25. Om  Sri

24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

34. Om  Sri
34. Om  Sri

35. Om  Sri
35. Om  Sri

33. Om  Sri
33. Om  Sri

32. Om  Sri
32. Om  Sri

31. Om  Sri
31. Om  Sri

30. Om  Sri
30. Om  Sri

29. Om  Sri
29. Om  Sri

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

Sai, You are the re-incarnation of Shirdi Sai
Sai, Shirdi Sai Moor........................................

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

42.  Om   Sri
42.  Om   Sri

41.  Om   Sri
41.  Om   Sri

39.  Om   Sri
39.  Om   Sri

38.  Om   Sri
38.  Om   Sri

37.  Om   Sri
37.  Om   Sri

36.  Om   Sri
36.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are affectionately related to everyone in
Sai, Loka Baadha-..................................................

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya

40. Om   Sri
40  Om   Sri

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are the Embodiment
Sai, Anan-...............................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

49. Om  Sri
49. Om  Sri

48. Om  Sri
48. Om  Sri

47. Om  Sri
47. Om  Sri

46. Om  Sri
46. Om  Sri

44. Om  Sri
44. Om  Sri

43. Om  Sri
43. Om  Sri

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Na-ma-hah..
Na-ma-hah..

Sai, You are the Giver of Freedom and Liber-
Sai, Mukthi Pra-.............................................

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                                 responsible for creation, preservation
Sa-i, Moor.................-.........................thi Thraya Svaroo...................-

  and de-..struc-tion,
.................paa - ya..

45. Om  Sri

45. Om  Sri

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

56. Om  Sri  Sai,
56. Om  Sri  Sai,

55. Om  Sri
55. Om  Sri

54. Om  Sri
54. Om  Sri

53. Om  Sri
53. Om  Sri

52. Om  Sri
52. Om  Sri

51. Om  Sri
51. Om  Sri

50. Om  Sri
50. Om  Sri

You are the Very First Person, the One who was
Aadi Puru-..............................................................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Giver of fruits of meritorious and be-ne-fi-
Sai, Punya Phala Pra-..........................................................

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

63. Om  Sri
63. Om  Sri

62. Om  Sri
62. Om  Sri

60. Om  Sri
60. Om  Sri

59. Om  Sri
59. Om  Sri

58. Om  Sri
58. Om  Sri

57. Om  Sri
57. Om  Sri

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

61.  Om  Sri   Sai,
61.  Om  Sri   Sai,
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70. Om  Sri
70. Om  Sri

64. Om  Sri
64. Om  Sri

65. Om  Sri
65. Om  Sri

66. Om  Sri
66. Om  Sri

67. Om  Sri
67. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sai, You are loved by all,
Sai, Priyaaya.................

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Inspirer and Granter of Love in all
Sai, Prema Pra-..........................................................
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71. Om  Sri
71. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

74. Om  Sri
74. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om  Sri
76. Om  Sri

77. Om  Sri
77. Om  Sri

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You dwell in the hearts of the de-
Sai, Bhaktha Jana Hridayala-...........

Sai, You are the Embodiment of Supreme
Sai, Jnaana Svaroo-.................................

Na - ma - hah.......
Na - ma - hah.......
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78. Om  Sri
78. Om  Sri

79. Om  Sri
79. Om  Sri

80. Om  Sri
80. Om  Sri

81. Om  Sri
81. Om  Sri

82. Om  Sri
82. Om  Sri

83. Om  Sri
83. Om  Sri

84. Om  Sri
84. Om  Sri

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sai, You bestow the fruits of all
Sao, Phala Pra-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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90. Om  Sri
90. Om  Sri

91. Om  Sri
91. Om  Sri

85. Om  Sri
85. Om  Sri

86. Om  Sri
86. Om  Sri

87. Om  Sri
87. Om  Sri

88. Om  Sri
88. Om  Sri

89. Om  Sri
89. Om  Sri

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..

Sai, You are the Embodiment of Success, Prosperity and Per-
Sai, Siddhi Roo-........................................................................

Sai, You are the Giver of all Desirable
Sai, Sarvaabheeshta Pra-....................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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92. Om  Sri
92. Om  Sri

93. Om  Sri
93. Om  Sri

94. Om  Sri
94. Om  Sri

95. Om  Sri
95. Om  Sri

96. Om  Sri
96. Om  Sri

97. Om  Sri
97. Om  Sri

98. Om  Sri
98. Om  Sri

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai, You purify the mind of Your de-
Sai, Saadhu Maanasa Parishodha-

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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105. Om  Sri
105. Om  Sri

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....

104. Om  Sri
104. Om  Sri

103. Om  Sri
103. Om  Sri

102. Om  Sri
102. Om  Sri

101. Om  Sri
101. Om  Sri

100. Om  Sri
100. Om  Sri

99. Om  Sri
99. Om  Sri

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are revered by the masters of
Sai, Yogindra Vandi-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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106.
106.

107.
107.

108.
108.
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

8. Om  Sri
8. Om  Sri

5. Om  Sri
5. Om  Sri

10. Om  Sri
10. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

9. Om  Sri
9. Om  Sri

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

19. Om  Sri
19. Om  Sri

15. Om  Sri
15. Om  Sri

20. Om  Sri
20. Om  Sri

21. Om Sri Sai,
21. Om Sri Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

18. Om  Sri
18. Om  Sri

16. Om Sri Sai,
16. Om Sri Sai,

12. Om  Sri
12. Om  Sri

17. Om  Sri
17. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Mahesvara Svaroo.......................................................................

Na-ma-hah....
Na-ma-hah....

Bhaarad-
.............

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

Sai,  You have manifested Yourself in the village Puttaparthi,
Sai,  Parthi Gramodbhavaaya...................................................
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Na - ma - hah.......
Na - ma - hah.......

24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

25. Om  Sri
25. Om  Sri

27. Om  Sri
27. Om  Sri

32. Om  Sri
32. Om  Sri

30. Om  Sri
30. Om  Sri

28. Om  Sri
28. Om  Sri

29. Om  Sri
29. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

31. Om Sri  Sai,
31. Om Sri  Sai,

You are the re-incarnation of Shirdi Sai
Shirdi Sai Moor........................................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

26. Om  Sri   Sai,

26. Om  Sri   Sai,

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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Na - ma - hah.......
Na - ma - hah.......

36. Om   Sri    Sai,
36. Om   Sri    Sai,

37. Om  Sri
37. Om  Sri

35. Om  Sri
35. Om  Sri

40. Om  Sri
40. Om  Sri

33. Om  Sri
33. Om  Sri

38. Om  Sri
38. Om  Sri

39. Om  Sri
39. Om  Sri

34. Om  Sri
34. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

42.  Om   Sri
42.  Om   Sri

43.  Om   Sri
43.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................

You are the Embodiment
Anan-...............................

You are affectionately related to everyone in
Loka Baadha-..................................................

41. Om   Sri   Sai,
41. Om   Sri   Sai,

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya
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Na - ma - hah.......
Na - ma - hah.......

47. Om  Sri
47. Om  Sri

50. Om  Sri
50. Om  Sri

48. Om  Sri
48. Om  Sri

52. Om  Sri
52. Om  Sri

49. Om  Sri
49. Om  Sri

51. Om   Sri    Sai,
51. Om   Sri    Sai,

53. Om  Sri
53. Om  Sri

54. Om  Sri
54. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

44. Om   Sri
44. Om   Sri

Na-ma-hah..
Na-ma-hah..

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

You are the Giver of Freedom and Liber-
Mukthi Pra-.............................................

46. Om  Sri  Sai,
46. Om  Sri  Sai,

You are the Giver of fruits of meritorious and be-ne-fi-
Punya Phala Pra-..........................................................

45. Om Sri

45. Om Sri

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...

  and de-..struc-tion,
...................paa - ya..

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                        responsible for creation, preservation
Sa-i, Moor...............-.....................thi Thraya Svaroo................-
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Na - ma - hah.......
Na - ma - hah.......

57. Om  Sri
57. Om  Sri

62. Om  Sri
62. Om  Sri

61. Om   Sri    Sai,
61. Om   Sri    Sai,

58. Om  Sri
58. Om  Sri

63. Om  Sri
63. Om  Sri

64. Om  Sri
64. Om  Sri

59. Om  Sri
59. Om  Sri

55. Om  Sri
55. Om  Sri

60. Om  Sri
60. Om  Sri

65. Om  Sri
65. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

56. Om  Sri  Sai,
56. Om  Sri  Sai,

You are the Very First Person, the One who was
Aadi Puru-..............................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye
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Na - ma - hah.......
Na - ma - hah.......

67. Om  Sri
67. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

74. Om  Sri
74. Om  Sri

70. Om  Sri
70. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om   Sri   Sai,
76. Om   Sri   Sai,

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are loved by all,
Sai, Priyaaya.................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

66. Om  Sri  Sai,
66. Om  Sri  Sai,

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

You are the Inspirer and Granter of Love in all
Prema Pra-..........................................................

You dwell in the hearts of the de-
Bhaktha Jana Hridayala-...........

You are the Embodiment of Supreme
Jnaana Svaroo-.................................

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

71. Om   Sri   Sai,
71. Om   Sri   Sai,
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Na - ma - hah.......
Na - ma - hah.......

81. Om   Sri   Sai,
81. Om   Sri   Sai,

77. Om  Sri
77. Om  Sri

82. Om  Sri
82. Om  Sri

87. Om  Sri
87. Om  Sri

78. Om  Sri
78. Om  Sri

83. Om  Sri
83. Om  Sri

79. Om  Sri
79. Om  Sri

84. Om  Sri
84. Om  Sri

80. Om  Sri
80. Om  Sri

85. Om  Sri
85. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

You bestow the fruits of all
Phala Pra-..........................

86. Om  Sri  Sai,
86. Om  Sri  Sai,

You are the Embodiment of Success, Prosperity and Per-
Siddhi Roo-........................................................................

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..

A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA
 

- Page 8



E B Gm

Gm Fm7 B

Cm Cm Fm E /B B 7 E A /C E

E E B 7

Ob-
daa -

jects,
ya

E

A A Fm

E B Gm

Gm Fm7 B

Cm Cm Fm E /B B 7 E A /C E

E E B 7

vo-
kaa-

tees,
ya

E

A A Fm

E B Gm

Na - ma - hah.......
Na - ma - hah.......

91. Om   Sri   Sai,
91. Om   Sri   Sai,

92. Om  Sri
92. Om  Sri

97. Om  Sri
97. Om  Sri

88. Om  Sri
88. Om  Sri

93. Om  Sri
93. Om  Sri

98. Om  Sri
98. Om  Sri

89. Om  Sri
89. Om  Sri

94. Om  Sri
94. Om  Sri

90. Om  Sri
90. Om  Sri

95. Om  Sri
95. Om  Sri

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

96. Om   Sri   Sai,
96. Om   Sri   Sai,

You are the Giver of all Desirable
Sarvaabheeshta Pra-....................

You purify the mind of Your de-
Saadhu Maanasa Parishodha-

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya

Na - ma -hah..
Na - ma -hah..
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101. Om   Sri   Sai,
101. Om   Sri   Sai,

102. Om  Sri
102. Om  Sri

103. Om  Sri
103. Om  Sri

99. Om  Sri
99. Om  Sri

104. Om  Sri
104. Om  Sri

100. Om  Sri
100. Om  Sri

105. Om  Sri
105. Om  Sri

106.
106.

107.
107.

108.
108.

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

You are revered by the masters of
Yogindra Vandi-..........................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

3. Om  Sri
3. Om  Sri

7. Om  Sri
7. Om  Sri

5. Om  Sri
5. Om  Sri

2. Om  Sri
2. Om  Sri

4. Om  Sri
4. Om  Sri

Sa - i, You are the Giver of Boons which promote inner development,
Sa - i, Varadaaya.....................................................................................

Sai, Your Mission is the revival of Truth and Righteousness,
Sai, Sathya Dharma Paraayanaaya.......................................

Sai, You are the Embodiment of Truth,
Sai, Sathya Svaroopaaya......................

6.  Om  Sri  Sai,
6.  Om  Sri  Sai,

Sai, You promote righteousness, piety and perfection,
Sai, Sadhu Vardhanaaya................................................

You are our Divine Mother, Divine Father and Divine
Sathya Sai Baa-..............................................................

You are the Embodiment of all virtuous qua-
Sathya Gunaath............................................

Sa - i, You....are the Universal Eternal....Abso..-..lute,
Sa - i,  Sat...................... Puru-...................shaa..-..ya.

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.

The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)

1.  Om  Sri  Sai,
1.  Om  Sri  Sai,

Key of E-flat
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

13. Om  Sri
13. Om  Sri

12. Om  Sri
12. Om  Sri

11. Om  Sri  Sai,
11. Om  Sri  Sai,

Sai, You are the Supreme Manifestation of All Godheads,
Sai, Sarveshaaya..................................................................

Sai, You are the One without attachment,
Sai, Sarva Sanga Parithyaagine...............

Sa - i,  You are the Indweller in everyone's heart,
Sa - i,  Sarva Antharyaamine................................

14. Om  Sri
14. Om  Sri

You are the Motivator of all Universal En-
Sarva Shakthi Moor..................................

10. Om  Sri
10. Om  Sri

Sa - i, You.......are the Beloved of......every-one,
Sa - i, Sarva...........Jana Pri-............yaa..-..ya

9. Om  Sri
9. Om  Sri

Sa - i,  You are the One who knows everything,
Sa - i,  Sarvajnaaya..............................................

8. Om  Sri
8. Om  Sri

Sai, You are the Protector and Sustainer of all good people,
Sai, Sadhujana Poshanaaya....................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

21. Om Sri Sai,
21. Om Sri Sai,

You have taken human form in the religious kin-group of Sage
Bhaaradvaaja Rishi Go-.................................................................

Bhaarad-
.............

Na-ma-hah....
Na-ma-hah....

19. Om  Sri
19. Om  Sri

20. Om  Sri
20. Om  Sri

18. Om  Sri
18. Om  Sri

17. Om  Sri
17. Om  Sri

16. Om  Sri
16. Om  Sri

15. Om  Sri
15. Om  Sri

Sa - i, You.... assumed the form and name: "Jodi Adipalli..So-mappa",
Sa - i, Jodi..................................Aadipalli......................Somap-paaya

Sa - i,  Your glory and fame is the same as that of Shirdi Sai Baba,
Sa - i,  Yasahkaaya Shirdi Vaasine...................................................

Sai, You are Omnipresent while Your physical body resides in Holy
Sai, Parthi Kshethra Nivaasine............................................................

Parthi,
...........

Sai, You have manifested Yourself in the village Puttaparthi,
Sai, Parthi Gramodbhavaaya...................................................

Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi-
Sai, Mahesvara Svaroo.......................................................................

Sa - i, You....are the Personification of....Glo-ry,
Sa - i, Ma.........-.............hima.......-.........atma-ne
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

26. Om  Sri   Sai,

26. Om  Sri   Sai,
...................................................traditional school of spiritual
Aapasthamba Su....................................................................

You chose to be born in the lineage of Sage Apasthamba's....

28. Om  Sri
28. Om  Sri

27. Om  Sri
27. Om  Sri

25. Om  Sri
25. Om  Sri

24. Om  Sri
24. Om  Sri

23. Om  Sri
23. Om  Sri

22. Om  Sri
22. Om  Sri

Sai, You have willed to take birth in the Ratnakara descendants,
Sai, Ratnaakara Vamshodhavaaya.................................................

Sai, You grant us the freedom from fear,
Sai, Abhaya Pradaaya..............................

Sa - i, You.............save us from.........all...fears,
Sa - i, Sarva...............Bhaya..........Nivaa-rine

Sa - i,  You are all Forms of God incarnated in one,
Sa - i, Avathaara Moortaye.......................................

Sai, You are the Innermost Self in every being,
Sai, Apaantharaathmane...................................

Sai, You are affectionate towards Your devotees like a mother,
Sai, Bhaktha Vathsalaaya............................................................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

34. Om  Sri
34. Om  Sri

35. Om  Sri
35. Om  Sri

33. Om  Sri
33. Om  Sri

32. Om  Sri
32. Om  Sri

31. Om  Sri
31. Om  Sri

30. Om  Sri
30. Om  Sri

29. Om  Sri
29. Om  Sri

Sa - i, You......save those who surrender.....to God,
Sa - i, Sara......-......naagatha Thraa......-....naa-ya

Sa - i,  You bestow vigor, energy, intelligence & divine power on us,
Sa - i,  Shakthi Pradaaya......................................................................

Sai, You moved about on the banks of the Chitravathi River in Parthi,
Sai, Chithraavathee Thata Puttaparthi Vihaarine.................................

Sai, You are still The Resident of "Dwarakamayi",
Sai, Dwaarakaamaayi Vaasine.............................

Sai, You are the re-incarnation of Shirdi Sai
Sai, Shirdi Sai Moor........................................

Sa - i, You...confer happiness & prosperity upon...your devotees,
Sa - i, Sham.............-..............karaa...........-..............ya.................

Sa - i,  Your magnificence is identical to that of Shirdi Sai Baba,
Sa - i,  Shirdi Sai Abheda Shaktyaavathaaraaya.......................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

42.  Om   Sri
42.  Om   Sri

41.  Om   Sri
41.  Om   Sri

39.  Om   Sri
39.  Om   Sri

38.  Om   Sri
38.  Om   Sri

37.  Om   Sri
37.  Om   Sri

36.  Om   Sri
36.  Om   Sri

Sai, You are fostering and guiding the interest of the whole world,
Sai, Lokarakshaa Paraayanaaya.......................................................

Sai, You are affectionately related to everyone in
Sai, Loka Baadha-..................................................

Sa - i, You.......are the One who is always.........with us,
Sa - i,  Asa...........-.........haaya Sahaa........-........yaa-ya

40. Om   Sri
40  Om   Sri

Sa - i,  You are the Savior of the helpless ones,
Sa - i,  Anaatha Naathaaya..............................

Sai, You are ever engaged in rescuing those in distress,
Sai, Artha Thraana Paraayanaaya................................

Sai, You are the Granter of Eternal Joy,
Sai,  Aananda Daaya...............................

Sai, You are the Embodiment
Sai, Anan-...............................
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

49. Om  Sri
49. Om  Sri

48. Om  Sri
48. Om  Sri

47. Om  Sri
47. Om  Sri

46. Om  Sri
46. Om  Sri

44. Om  Sri
44. Om  Sri

43. Om  Sri
43. Om  Sri

Sa - i,  You are the Sustainer and Supporter of all,
Sa - i,  Sarva Adhaaraaya........................................

Sai, You are full of compassion and kindness,
Sai, Karunaakaraaya......................................

Sai,  You are Perfect and All Powerful,
Sai,  Kalusha Vidooraaya.....................

Na-ma-hah..
Na-ma-hah..

Sai, You are the Giver of Freedom and Liber-
Sai, Mukthi Pra-.............................................

  and de-..struc-tion,
.................paa - ya..

45. Om  Sri

45. Om  Sri

Sa - i,  You nourish and sustain the afflicted ones,
Sa - i,  Deenajana Poshanaaya...............................

Sai, You are the Divine Master of Mankind,
Sai, Lokanathaaya........................................

Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
                                           responsible for creation, preservation
Sa-i, Moor.................-.........................thi Thraya Svaroo..............-
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

56. Om  Sri  Sai,
56. Om  Sri  Sai,

55. Om  Sri
55. Om  Sri

54. Om  Sri
54. Om  Sri

53. Om  Sri
53. Om  Sri

52. Om  Sri
52. Om  Sri

51. Om  Sri
51. Om  Sri

50. Om  Sri
50. Om  Sri

You are the Very First Person, the One who was
Aadi Puru-..............................................................

Sa - i,  You....are the One Creator who is praised....eter-nally,
Sa - i,  A........-.........nantha Nutha Keer..........-.........tha-naaya

Sa - i,  You are the Destroyer of all sufferings,
Sa - i,  Sarva Baadha Haraaya........................

Sai, You are the Healer of all aliments and diseases,
Sai, Sarva Roga Nivaarine........................................

Sai, You are the Savior from consequences of all immoral activities,
Sai, Sarva Paaya Kshaya Karaaya.....................................................

Sai, You are the Giver of fruits of meritorious and be-ne-fi-
Sai, Punya Phala Pra-..........................................................

Sa - i, You...dwell in the region of the Heart...of all...beings,
Sa - i, Sar.........-..........va Hrud............-..............va..-...sine...
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Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

63. Om  Sri
63. Om  Sri

62. Om  Sri
62. Om  Sri

60. Om  Sri
60. Om  Sri

59. Om  Sri
59. Om  Sri

58. Om  Sri
58. Om  Sri

57. Om  Sri
57. Om  Sri

Sai, You are the Savior in times of calamity,
Sai, Aapad Baandhavaaya...........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, Your astonishing actions are not seen in anyone else,
Sai,  Adbhutha Charyaa........................................................

You wear golden robes, the color
Kanakaambara Dhaa-................

Sa - i, You....are the Destroyer of desire....and...anger,
Sa - i, Kama........-.........krodha...............Dhwam - sine

Sa - i,  You are the Formless who has assumed human form,
Sa - i,  Avyaktha Roopine..........................................................

Sai, You have delightful and wonderful powers,
Sai, Aparoopa Shakthine.....................................

Sai, You are the Infinite Power of the Divine Mother,
Sai, Aadi Shakthaye......................................................

61.  Om  Sri   Sai,
61.  Om  Sri   Sai,
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70. Om  Sri
70. Om  Sri

64. Om  Sri
64. Om  Sri

65. Om  Sri
65. Om  Sri

66. Om  Sri
66. Om  Sri

67. Om  Sri
67. Om  Sri

68. Om  Sri
68. Om  Sri

69. Om  Sri
69. Om  Sri

Sa - i,    You....are playing in the hearts of....your bhakthas,.
Sa - i,    Bhaktha.......Jana Hridaya ..............Vi  -  haaraaya

Sa - i,  You are the heavenly 'Wish-fulfilling Tree' for Your devotees,
Sa - i,  Bhaktha Mandaaraaya.............................................................

Sai, You guide and guard the ones who surrender to God,
Sai, Bhaktha Priyaaya..........................................................

Sai, You are loved by all,
Sai, Priyaaya.................

Sa - i,    You...are the Embodiment of....Divine Love,
Sa - i,    Pre.......-..........ma.......................Moor-thaye

Sa - i,  You are Supreme Love,
Sa - i,  Premaatmane..............

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You are the Inspirer and Granter of Love in all
Sai, Prema Pra-..........................................................
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71. Om  Sri
71. Om  Sri

72. Om  Sri
72. Om  Sri

73. Om  Sri
73. Om  Sri

74. Om  Sri
74. Om  Sri

75. Om  Sri
75. Om  Sri

76. Om  Sri
76. Om  Sri

77. Om  Sri
77. Om  Sri

Sai, You are the Giver and Teacher of the 'Gita',
Sai, Geethaa Bodhakaaya...................................

Sa - i,    You...show the path of attaining...right knowledge,
Sa - i,    Su......-......jnaana Maarga............Darsa - kaaya.

Sa - i,  You are the Grantor of devotion and wisdom,
Sa - i,  Bhakthi Jnaana Pradaaya.............................

Sai, You illuminate the light of devotion and spiritual knowledge
Sai, Bhakthi Jnaana Pradeepaaya.................................................

Sai, You are bound by the devotion of Your followers,
Sai, Bhaktha Paraadheenaaya....................................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Sai, You dwell in the hearts of the de-
Sai, Bhaktha Jana Hridayala-...........

Sai, You are the Embodiment of Supreme
Sai, Jnaana Svaroo-.................................

Na - ma - hah.......
Na - ma - hah.......
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78. Om  Sri
78. Om  Sri

79. Om  Sri
79. Om  Sri

80. Om  Sri
80. Om  Sri

81. Om  Sri
81. Om  Sri

82. Om  Sri
82. Om  Sri

83. Om  Sri
83. Om  Sri

84. Om  Sri
84. Om  Sri

Sa -i,  Your Glory pervades the Universe and transcends it,
Sa -i,  Atheethaaya...................................................................

Sai,  You are ever existent and permanent,
Sai,  Puraana Purushaaya.........................

Sai, You are supreme above all,
Sai, Purushothamaaya.............

Sa - i,   You....are the Embodiment of....Pu-rity,
Sa - i,  Pun......-........ya Puru. ......-.......shaa-ya

Sa -i,  You have a charming Divine Form,
Sa -i,  Sundararupaaya............................

Sai,  You grant the urge for spiritual awareness,
Sai,  Jnana Siddhidaaya......................................

Sai, You bestow the fruits of all
Sao, Phala Pra-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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90. Om  Sri
90. Om  Sri

91. Om  Sri
91. Om  Sri

85. Om  Sri
85. Om  Sri

86. Om  Sri
86. Om  Sri

87. Om  Sri
87. Om  Sri

88. Om  Sri
88. Om  Sri

89. Om  Sri
89. Om  Sri

Sa - i,   You...destroy the cycle of birth and...death sufferings,
Sa - i,   Sam.....-........saara Duhkha..............Kshaya Karaaya

Sa -i,  You are providing food, shelter and sustenance for all,
Sa -i,  Annavastradaaya.............................................................

Sai,  You bless us with good health and well being,
Sai,  Aarogya Pradaaya...........................................

Sai, Your power of will is immediately effective,
Sai, Siddha Sankalpaaya...................................

Sa - i, You.........are be..-..yond Time,
Sa - i, Kaa...-...laathee..-..taa..-..ya..

Sai, You are the Embodiment of Success, Prosperity and Per-
Sai, Siddhi Roo-........................................................................

Sai, You are the Giver of all Desirable
Sai, Sarvaabheeshta Pra-....................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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92. Om  Sri
92. Om  Sri

93. Om  Sri
93. Om  Sri

94. Om  Sri
94. Om  Sri

95. Om  Sri
95. Om  Sri

96. Om  Sri
96. Om  Sri

97. Om  Sri
97. Om  Sri

98. Om  Sri
98. Om  Sri

Sai,  You are the Destroyer of All Doubts,
Sai,  Sakala Samsaya Haraaya................

Sai, You have planted the Banyan tree as a boon for spiritual
Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..

enlightenment,
.........................

Sa - i,   You...accept and represent...all re-ligions,
Sa - i,   Sarva.....-......mata............Samma-thaaya

Sa -i,  You shine in the mind of good persons as brilliant knowledge,
Sa -i,  Saadhu Maanasa Sobhithaaya...................................................

Sai,  You are the Destroyer of the Bondage of Karma,
Sai,  Karma Dhwamsine................................................

Sai,  You are full of beneficial virtues,
Sai,  Kalyana Gunaaya......................

Sai, You purify the mind of Your de-
Sai, Saadhu Maanasa Parishodha-

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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105. Om  Sri
105. Om  Sri

Sa - i,   You....destroy physical and....mental distress.
Sa - i,   Aar.......-........thiha..........-.........raa...-.....ya.....

104. Om  Sri
104. Om  Sri

103. Om  Sri
103. Om  Sri

102. Om  Sri
102. Om  Sri

101. Om  Sri
101. Om  Sri

100. Om  Sri
100. Om  Sri

99. Om  Sri
99. Om  Sri

Sa - i,  You are the Remover of Misfortunes,
Sa - i,  Aapannivarine...................................

Sai,  You are the Bestower of All Accomplishments,
Sai,  Sarvasiddhi Pradaaya.....................................

Sai, You are the Granter of Benevolence,
Sai, Sarva Mangalakaraaya...................

Sa - i,   You...are the Lord of...all Yogis,
Sa - i,   Yo.....-.....giswa.....-.....raa - ya...

Sa -i,  You are the Teacher of All Spiritual Wisdom,
Sa -i,  Sakalathathwa Bodhakaaya.........................

Sai, You are revered by the masters of
Sai, Yogindra Vandi-..........................

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......

Na - ma - hah.......
Na - ma - hah.......
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F

A mil-lion

G7

hearts in
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Written by Dennis Gersten  Text and melody transcribed from the recording: STREAM OF MERCY DIVINE.
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A  CROWN  OF  HAIR



A Crown of Hair, an or - ange robe,

Lov - ing eyes, a heart of gold,

He floats to us a - cross the sand,

Sa - cred Ash pours from His Hand,

Mil- lions call Him liv - ing Lord,

the liv - ing Lord is He

Written by Dennis Gersten  Text and melody transcribed from the recording: STREAM OF MERCY DIVINE.
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Mil- lions wait with tear- ful eyes, tear- ful

eyes with joy in - side.

A mil - lion hearts in sweet de - vo - tion

filled with the love of the Lord.

"I do not mention Sai Baba in any of my discourses, but I bear
the name as Avatar of Sai Baba.  I do not appreciate in the least

the distinction between the various appearances of God: Sai,
Rama. Krishna, etc. I do not proclaim that this is more

important or that the other is less important. Continue your
worship of your chosen God along lines already familiar to you,

then you will find that you are coming nearer to me, for all
names are mine and all forms are mine.  There is no need to

change your chosen God and adopt a new one when you have
seen me and heard me."  --Sathya Sai Baba

Copyright - All Rights Reserved.  Permission Granted for Non-Commercial Use for the Purpose of Photo-copying the Music
for Personal or Group Devotional Singing.  Recording Rights or Mass Redistribution Rights are Not Granted for

Commercial or Non-Commercial Use.  Contact the Owner of the Copyright for Permission. The Web Site Will Not Grant
Permission for Any Other Use Held by the Owner of the Copyright.

A  CROWN  OF  HAIR   (Page 2)



&
# #

# #
4
4

Al -

j
œ

le -

j
œ

E

lu -

œ œ
jah!

j̊
œ

B

˙
Al-

j
œ

le -

J
œ

A

lu -

œ œ œ œ
B

jah!

œ

Al-

j
œ

le -

j
œ

E

lu -

J
œ .

jah!

J
œ

B

˙

Al -

œ œ

le -

j
œ

&
# #

# #
A

lu -

œ œ œ œ œ

B

jah!

œ
Al -

j
œ

le -

j
œ

E

lu -

œ œ
jah!

j̊
œ

B

˙
Al -

j
œ

le -

J
œ

A

lu -

œ œ œ œ
B

jah!

œ

Al -

j
œ

le -

j
œ

&
# #

# #
E

lu-

J
œ .

jah!

J
œ

B

˙

Al -

œ œ

le -

j
œ

A

lu -

œ œ œ œ œ

B

jah!

œ
Al-

j
œ

le -

j
œ

E

lu -

œ œ
jah!

j̊
œ

A/E

˙
Al-

j
œ

le -

j
œ

Fine
E

lu -

œ œ
jah!

j̊
œ ˙ .

&
# #

# #
A

Œ

I

œ œ

am

J
œ

E

here

˙
A

J
œ.

to

J
œ

dry

œ œ

your

J
œ

E

tears.

˙

&
# #

# #
A

J
œ .

The

J
œ

pure

œ œ

in

J
œ

E

heart

J
œ.

know

J
œ

J
œ

J
œ

My

J
œ

B

Name.

˙ .

Age

J
œ

to

J
œ

&
# #

# #
A

Age

J
œ.

I

J
œ œ œ

re -

J
œ

E

turn

œ .

Bring-

j̊
œ

ing

J
œ

A

love

J
œ.

to

J
œ

all

œ œ

who

J
œ

E

yearn

œ
J
œ

For

J
œ

the

J
œ

&
# #

# #
F #m

day

œ

when

j̊
œ

all

J
œ .

E/G #

na -

J
œ

tions

J
œ .

Stand

j
œ

and

J
œ

A

sing

œ

in

j
œ

one

J
œ

B

voice....

œ

Text, melody and harimonization authored by Ladd Bogdonoff, California, USA.
CHORUS

VERSE

_____

Copyright - All Rights Reserved.  Permission Granted for Non-Commercial Use for the Purpose of Photo-copying the
Music for Personal or Group Devotional Singing.  Recording Rights or Mass Redistribution Rights are Not Granted for

Commercial or Non-Commercial Use.  Contact the Owner of the Copyright for Permission. The Web Site Will Not Grant
Permission for Any Other Use Held by the Owner of the Copyright.

ALLELUJAH!



& c .. ...œ jœ œ œ œ
UC

All my love to You,

.œ jœ œ œ
Dm

all my love to

1

w
G

You

2

.˙ œ
G

You You're

& .. ..˙ œ œ
C

brin - ging Pra -

˙ œ œ
Em

shan - ti Ni -

1 .œ jœ œ œ
F

lay - am in my

.˙ œ
G

heart, You're

.œ jœ œ œ
F

lay - am in my

2

w
G

heart.

& .œ jœ œ œ
Dm

Lo - ve in my

w
G

heart,

.œ jœ œ œ
C

love for ev - 'ry

w
Am

one,

.œ jœ œ œ
Dm

pea - ce in my

& w
G

heart,

.œ jœ œ œ
C

peace for ev - 'ry

w
Am

one,

œ œ œ œ
F

light in my

.˙ œ
G

heart. You're

& .. ...œ jœ ˙
C

brin - ging love,

.œ jœ œ œ
Em

brin - ging peace and

œ œ œ œ
F

li - ght in my

1

.˙ œ
G

heart. You're

w
heart.

ALL MY LOVE TO YOU
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(Repeat two more times)

(Repeat again)

Lyrics by Christiane Both, music by Ladd Bogdonoff.
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Lyrics by Christiane Both, music by Ladd Bogdonoff.
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all
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˙
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˙
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˙
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œ ˙ .w

˙
˙

˙̇b

˙̇ ..
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œœ

˙̇b ˙
˙
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..

(Repeat two more times)

(Repeat again)

Lyrics by Christiane Both, music by Ladd Bogdonoff.
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Where -Where -

1)canon
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.œ Jœ œ
C

ev - er I

.œ Jœ œ
G

go on - ly

.œ Jœ œ
F

You, on - ly

˙
G

You,

2)& œ
just

.œ Jœ œ
You al -ways

.œ Jœ œ
You al -ways

.œ Jœ œ
You al -ways

.œ
You

3)

& œ œ Jœ
oh Lo - rd

.œ Jœ œ
You al -al -ways

.œ Jœ œ
You al -ways

.œ Jœ œ
You al -ways

˙
You

4)& œ
just

œ œ œ
You al - ways

œ œ œ
You al - ways

œ .œ Jœ
You - al - ways

œ œ
You al -

5)& ..œ
ways

.˙
You

.˙
You

œ œ œ
You al - ways

˙
You.

& œ
Just

.....˙̇̇̇̇
You

.....˙̇̇̇̇

ALWAYS YOU
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Text from a poem by Rabbi Levi Jizchak, melody and harmonizations authored by Heinz Malina, Austria
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Voice 1

Voice 2

Voice 3

Voice 4

Voice 5

Œ Œ œ
Where -∑
∑
∑
∑

.œ Jœ œ
C

ev - er I∑
∑
∑
∑

.œ Jœ œ
G

go, on - ly∑
∑
∑
∑

.œ Jœ œ
F

You, on - ly∑
∑
∑
∑

˙ œ
G

You, justŒ Œ œ
∑
∑
∑

&
&
&
&
&

 1

 2

 3

 4

 5

6 .œ Jœ œ
You al - ways,.œ Jœ œ
C

∑
∑
∑

.œ Jœ œ
You al-ways,.œ Jœ œ
G

∑
∑
∑

.œ Jœ œ
You al - ways.œ Jœ œ
F

∑
∑
∑

.œ Jœ œ œ
You, oh Lo- rd

˙ œ
G

Œ Œ œ
∑
∑

.œ Jœ œ
You al-ways,.œ Jœ œ
.œ Jœ œ

C

∑
∑

.œ Jœ œ
You al-ways,.œ Jœ œ
.œ Jœ œ

G

∑
∑

ALWAYS YOU
Kanon
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12 .œ Jœ œ
You al - ways.œ Jœ œ
.œ Jœ œ
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∑
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˙ œ
You, just

.œ Jœ œ œ

˙ œ
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Œ Œ œ
∑

œ œ œ
You al - ways,.œ Jœ œ
.œ Jœ œ
.œ Jœ œ
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∑

œ œ œ
You al - ways,.œ Jœ œ
.œ Jœ œ
.œ Jœ œ

G

∑

œ .œ Jœ
You al - ways.œ Jœ œ
.œ Jœ œ
.œ Jœ œ
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∑

œ œ œ
You al - ways,˙ œ
.œ Jœ œ œ

˙ œ
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Œ Œ œ
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&
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18 .˙
You,œ œ œ
.œ Jœ œ
.œ Jœ œ
.œ Jœ œ
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.˙
You,œ œ œ
.œ Jœ œ
.œ Jœ œ
.œ Jœ œ

G

œ œ œ
You al - ways

œ .œ Jœ
.œ Jœ œ
.œ Jœ œ
.œ Jœ œ

F

˙ œ
You. Where -œ œ œ
˙ œ
.œ Jœ œ œ

˙ œ
G

.œ Jœ œ
C

ev - er I.˙
œ œ œ
.œ Jœ œ
.œ Jœ œ

.œ Jœ œ
G

go, on - ly.˙
œ œ œ
.œ Jœ œ
.œ Jœ œ
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You, on - ly

œ œ œ
œ .œ Jœ
.œ Jœ œ
.œ Jœ œ

˙ œ
G

You, just˙ œ
œ œ œ
˙ œ
.œ Jœ œ œ

.œ Jœ œ
You al - ways,.œ Jœ œ
C

.˙
œ œ œ
.œ Jœ œ

.œ Jœ œ
You al - ways,.œ Jœ œ
G

.˙
œ œ œ
.œ Jœ œ

.œ Jœ œ
You al - - - -ways.œ Jœ œ
F

œ œ œ
œ .œ Jœ
.œ Jœ œ
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oh Lo- rd

˙ œ
G

˙ œ
œ œ œ
˙ œ

&
&
&
&
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30 .œ Jœ œ
You al - ways,.œ Jœ œ
.œ Jœ œ

C

.˙
œ œ œ

.œ Jœ œ
You al - ways,.œ Jœ œ
.œ Jœ œ

G

.˙
œ œ œ

.œ Jœ œ
You al - ways.œ Jœ œ
.œ Jœ œ

F

œ œ œ
œ .œ Jœ

˙ œ
You, just

.œ Jœ œ œ

˙ œ
G

˙ œ
œ œ œ

œ œ œ
You al - ways,.œ Jœ œ
.œ Jœ œ
.œ Jœ œ

C

.˙

œ œ œ
You al - ways,.œ Jœ œ
.œ Jœ œ
.œ Jœ œ

G

.˙
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You al - ways.œ Jœ œ
.œ Jœ œ
.œ Jœ œ

F

œ œ œ

˙ œ
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˙ œ

.˙
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˙
˙
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˙
˙



A -
'Twas
When

Through

maz -
Grace
we've
man -

ing
that
been

y

Grace,
taught
there

tri -

how
my
ten
als,

sweet
heart
thou -
toils

the
to

sand
and

sound
fear

years
snares

That
And

Bright
I

saved
Grace
shin -
have

a
my
ing
al -

soul
fear
as

read -

like
re -

the
y

me.
lieved.
sun.

come.

I
How

We've
'Twas

once
pre -
no

Grace

was
cious
less
that

lost,
did

days
led

but
that
to
me

now
Grace
sing

through

I'm
ap -

God's
thus

found,
pear

praise
far

Was
The

Than
And

blind,
hour
when
Grace

but
I

we
will

now
first
first
lead

I
be -
be -
me

see.
lieved.
gun.
on.

Early American melody with harmonizations
submitted by transcriber. (25 June 1996)

Text adapted from the Arizona
devotees' song book: BHAJANS.

1.
2.
3.
4.
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A -
'Twas
When

Through

G

maz -
Grace
we've
man -

ing
that
been

y

G7

Grace,
taught
there

tri -

how
my
ten
als,

C

sweet
heart
thou -
toils

D7

the
to

sand
and

G

sound
fear

years
snares

D7

That
And

Bright
I

G

saved
Grace
shin -
have

Em

a
my
ing
al -

A7

soul
fear
as

read -

like
re -

the
y

D

me.
lieved.
sun.

come.

D7

I
How

We've
'Twas

G

once
pre -
no

Grace

Bm

was
cious
less
that

Em

lost,
did

days
led

G7

but
that
to
me

C

now
Grace
sing

through

I'm
ap -

God's
thus

G

found,
pear

praise
far

D7

Was
The

Than
And

Em

blind,
hour
when
Grace

A7

but
I

we
will

G

now
first
first
lead

D7

I
be -
be -
me

G G7 C

see.
lieved.
gun.
on.

G

1.
2.
3.
4.

Early American melody with harmonizations
submitted by transcriber. (25 June 1996)

Text adapted from the Arizona
devotees' song book: BHAJANS.
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& ### c .. œ œ jœ œ jœ œ œ
A

An -

No -
Some -

Ev -
y
er -

thing

thing
y

thing
on

goes
thing

gets

with
that

you
the

in -
you

mov -
out -

spir -
feel

ing
side

œ œ Jœ .œ Jœ
E

a -
from

a -
mat -

tion
your

bout,
ters

from
he -
any -

God,
art,

more,

so

so
so

& ### .. .. ..3 œ œ œ Jœ œ Jœ
E7

go
go
go
go

for
for
for
for

it;
it;
it;
it;

let
let
let
let

œ Jœ .œ œA

it
it
it
it

hap -
hap -
hap -
hap -

pen!
pen!
pen!
pen!

Chorusœ .˙
So far,

œ .˙E
So Good

œ Jœ .œ œ
E7 A

feel hap - py!

& ###8 Last Verse:Jœ
This

œ œ jœ .œ jœ
some - thing is God, and

œ œ œ .œ Jœ
E

God is One's self, So

œ Jœ œ ‰ œ œ
E7

go for it, Let it

& ###12

Jœ .˙ jœ
A

hap - - - pen!

ANYTHING GOES
Words and Music ©1995 Ulla Dürnfelder

©1995 Ulla Dürnfelder
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A -
From

sa -
un-

tho
truth

Maa
lead

Sad
me

Ga -
to

ma -
the

ya
truth,

Tha -
From

ma - so
dark -

Maa
ness

Jyo -
lead

thir
me

Ga -
to

ma -
the

ya
light,

Mrith -
From

yor
death

Maa
lead me

Am-
to

ri-
im-

tam
mor -

Ga-
tal -

ma-
i -

ya
ty.

Om,
Om,

Shan -
Peace,

ti, Shan -
Peace,

ti, Shan -
Peace.

ti.

This is the real meaning of the Manthra.

(Portions of a quotation of Bhagavan Sri Sathya Sai Baba, appearing in the
book, DIGEST, which is a collection of His sayings.)

3. "O Lord, bless me through Your Grace with Immortality, or
Paramananda, resulting from the awareness of the effulgence of the

Atma, immament in every object."

2. "O Lord, when the objects of this world attract me, remove the
darkness which hides the all-pervading Atma, which every such

object really is."

This Mantra is comprised of three prayers.

1. "O Lord, when I am deriving happiness through the objects of
this world, make me forget the unreal objects and show me the way

to permament happiness."

*Optional

(FROM UNTRUTH LEAD ME TO THE TRUTH)

(us)

(us)

(us)

Transcribed from a recording of BHAGAVAN SRI SATHYA SAI BABA singing this mantra.
English text adapted from various translations by Dennis Neal, USA.
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un-

tho
truth

Dm

Maa
lead

C7

Sad
me

Ga -
to

ma -
the

F

ya
truth,

Am

Tha -
From

ma - so
dark -

Dm

Maa
ness

Gm

Jyo -
lead

thir
me

C7

Ga -
to

ma -
the

F

ya
light,

Gm

Mrith -
From

yor
death

C7

Maa
lead me

Am -
to

ri -
im -

Am

tam
mor -

Ga-
tal -

ma -
i -

F

ya
ty.

F

Om,
Om,

F

Shan -
Peace,

E

ti,

F

Shan -
Peace,

E

ti,

F

Shan -
Peace.

E

ti.

F
*Optional

Transcribed from a recording of BHAGAVAN
SRI SATHYA SAI BABA singing this mantra.

(us)__

(us)

(FROM  UNTRUTH LEAD  ME  TO  THE  TRUTH)

(us)

This is the real meaning of the Manthra.

(Portions of a quotation of Bhagavan Sri Sathya Sai Baba, appearing in
the book, DIGEST, which is a collection of His sayings.)

3. "O Lord, bless me through Your Grace with Immortality, or
Paramananda, resulting from the awareness of the effulgence of the

Atma, immament in every object."

2. "O Lord, when the objects of this world attract me, remove the
darkness which hides the all-pervading Atma, which every such

object really is."

This Mantra is comprised of three prayers.

1. "O Lord, when I am deriving happiness through the objects of
this world, make me forget the unreal objects and show me the way

to permament happiness."

Copyright - All Rights Reserved.  Permission Granted for Non-Commercial Use for the Purpose of Photo-
copying the Music for Personal or Group Devotional Singing.  Recording Rights or Mass Redistribution

Rights are Not Granted for Commercial or Non-Commercial Use.  Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the

Copyright.

English text adapted from several
translations by Dennis Neal, USA.
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The melody is adapted from the Bhajan: GANESHA CHARANAM which was
transcribed from the soundtrack of the film: SATHYA SAI BABA: THE EARLY YEARS.

The text is authored by Radha Sahar, New Zealand.

AS  WE  BEGIN
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The melody is adapted from the Bhajan: GANESHA CHARANAM which was
transcribed from the soundtrack of the film: SATHYA SAI BABA: THE EARLY YEARS.

The text is authored by Radha Sahar, New Zealand

AS  WE  BEGIN



& ### c .. ..wwwF
#m www

E www
D www

C#

& ### ..5 www
C# www

C# ˙̇̇ œœœ ‰ jœ
C#

We're

% ‰ œ œ œ œ œ œF#

nev-er a-way from the -

‰ œ œ œ œ œ œ
E

A-va- tar Eyes

& ###10 ‰ œ œ œ œ œ œ
D

A -va - tar Eyes Sai

‰ œ# œ œ .œ jœ
C#

A-va- tar Eyes. We're

‰ œ œ œ œ œ œF#

nev-er a-way from the

‰ œ œ œ œ œ œ
E

A - va- tar Eyes

& ### .. ..14 ‰ œ œ œ œ œ œ
D

A-va-tar Eyes Sai

‰ œ# œ œ .œ jœ
C#

A-va-tar Eyes. We're

‰ œ œ œ œ œ œF#m

on-ly as far as the

‰ œ œ œ œ œ œE

space from our hearts He

& ###18 ‰ œ œ œ œ œ œD

lives in our hearts He

‰ œ# œ œ .œ jœ
D

lives in our hearts We're

‰ œ œ œ œ œ œF#m

on-ly as far as the

‰ œ œ œ œ œ œE

space from our hearts He

& ### .. ..22 ‰ œ œ œ œ œ œD

lives in our hearts He

‰ œ# œ œ .œ jœ
C#

lives in our hearts (We're)

‰ œ œ œ œ œ œF#m

1.2.
3.4.

We're
Sooth-

nev-
ing

er
our

lost,
souls

he is
with
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al-
A -

ways
va -

the
tar

Light
Eyes

& ###26 ‰ œ œ œ œ œ œF#m

al-
A -

ways
va -

the
tar

Light
Eyes

Sai
Sai

‰ œ œ œ ˙C#

al-
A -

ways
va -

the
tar

Light.
Eyes.

‰ œ œ œ œ œ œF#m

We're
Sooth-

nev-
ing

er
our

lost,
souls

he is
with

‰ œ œ œ œ œ œD

al-
A -

ways
va -

the
tar

Light
Eyes

& ### ..30 ‰ œ œ œ œ œ œF#m

Al -
A -

ways
va -

the
tar

Light
Eyes

Sai
Sai

‰ œ œ œ ˙C#

Al -
A -

ways
va -

the
tar

Light
Eyes.

D.S. al CodaÓ Œ ‰ jœ
C#

We're

fi‰ œ œ œ œ œ œF#m

nev- er a way from the

& ###34 ‰ œ œ œ œ œ œ
E

A - va - tar Eyes

‰ œ œ œ œ œ œ
D

A - va - tar Eyes Sai

‰ œ# œ œ ˙
C#

A - va - tar Eyes.

∑F#m

Avatar Eyes Words and Music by Dennis Gersten
©1985 Shiva Sunrise Music
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(Solo)

(Solo)

(All)

Solo

(4x)

(Solo)

(All)

(Solo on D.S.)
(All on Coda)

(Slow)



& # 44 .. œ
B7

We're

œ jœ jœ œ jœ jœ
Em

nev - er a-way from the

≈ j̊œ œ jœ œ œ œ
Bm

A - va - tar eyes,

& # ..≈ j̊œ œ jœ œ jœ jœ
Am

A - va - tar eyes, Sa - i,

≈ j̊œ# œ jœ œ
B

A - va - tar eyes.

& # .. œ
B7

We're

j̊œ j̊œ œ jœ œ jœ jœ
Em

on - ly as far as the

‰ jœ j̊œ .jœ œ jœ jœ
D

space from our hearts, He

& # ..‰ jœ j̊œ .jœ œ jœ jœ
C

lives in our hearts, He

1‰ jœ# j̊œ .jœ œ
B

lives in our hearts.

2‰ jœ# j̊œ .jœ ˙
B

lives in our hearts.

& # .. ‰ . Jœ Jœ .Jœ œ
j̊œ .Jœ

Em

We're nev - er lost, He is

‰ . Jœ Jœ Jœ œ œ œAm

al - ways the Light,

& # ..‰ . Jœ Jœ Jœ œ jœ jœ
Em

al - ways the Light, Sa - i,

‰ jœ j̊œ .jœ ˙B B7

al - ways the Light

& # .. ‰ . Jœ Jœ Jœ œ j̊œ .Jœ
Em

Sooth - ing our souls with

‰ . Jœ Jœ Jœ œ œ œAm

A - va - tar eyes,

& # ..‰ . Jœ Jœ Jœ œ
jœ jœ

Em

A -va - tar eyes, Sa - i,

1‰ jœ j̊œ .jœ ˙
B B7

A - va - tar eyes.

2‰ jœ j̊œ .jœ œ
B B7

A-va - tar eyes.

  Words and Music by Dennis Gersten  ©1985 Shiva Sunrise Music
This is a variation with text and melody provided by the devotees of the Phoenix, Arizona Sai Center. Harmonizations 

submitted by the transcriber. (16 Feb 1997)

AVATAR  EYES - Variation
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A - va - tar eyes,≈ j̊œ œ jœ œ œ œw

&
?

#

#

..

..

≈ j̊œœ œœ jœ œœ jœ jœ
A - va - tar eyes, Sa - i,≈ j̊œ œ jœ œ jœ jœw

≈ j̊œœ# œœ jœ œœ
A - va - tar eyes.≈ j̊œ œ jœ œw
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œœ#
We'reœœ

j̊œœ j̊œœ œœ jœœ œœ jœœ jœœ
on - ly as far as theww

‰ jœœ j̊œœ ..jœœ œœ jœœ jœœ
space from our hearts, Heww

&
?

#

#

..

..

‰ jœœ j̊œœ ..jœœ œœ jœœ jœœ
lives in our hearts, He

ww

1‰ jœœ# j̊œœ ..jœœ# œœ
lives in our hearts.

˙̇ œœ

2‰ jœœ# j̊œœ ..jœœ# ˙̇
lives in our hearts.

˙̇ ˙̇

AVATAR  EYES (Variation- Page 1)

This is a variation with text and melody provided by the devotees of the Phoenix, Arizona Sai Center. 
Harmonizations submitted by the transcriber. (10 May 1997)

Words and Music by Dennis Gersten  ©1985 Shiva Sunrise Music
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jœœ œœ jœœ jœ

al - ways the Light, Sa - i,‰ . j̊œ jœ jœ œ jœ jœw

‰ jœœ# j̊œœ ..jœœ ˙̇
al - ways the Light‰ jœ j̊œ .jœ ˙w
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‰ . j̊œœ
jœœ
jœœ œœ œ ..œœ

Sooth - ing our souls with‰ . j̊œ jœ jœ œ œ .œw

‰ . j̊œœ
jœœ
jœœ œœ œœ œ

A - va - tar eyes,‰ . j̊œ jœ jœ œ œ œw
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?

#

#

..

..

‰ . j̊œœ
jœœ
jœœ œœ jœœ jœ

A -va - tar eyes, Sa - i,‰ . j̊œ jœ jœ œ jœ jœw

1‰ jœœ# j̊œœ ..jœœ ˙̇
A - va - tar eyes.‰ jœ j̊œ .jœ ˙w

2‰ jœœ# j̊œœ ..jœœ œœ
A-va - tar eyes.‰ jœ j̊œ .jœ œw

AVATAR  EYES (Variation- Page 2)
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sleep
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rise,
one,
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& #### .œ jœ .œ jœ
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wake,
rise,
out,
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a -
sing

wake,
rise -
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œ œ œ œ .œ jœ
life
like
Lord
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a
of

just
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truth

a
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come,
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sing

.œ jœ .œ jœ
B

wake,
rise,
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sing
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your

the

œ œ œ œ .œ jœ
life
like
Lord
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a
of
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a
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veal
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your
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.œ jœ# .œ jœ
B

veal,
veal,
veal,

re -
re -
re -

veal,
veal,
veal,

the
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veal.
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AWAKE AWAKE
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  Text, melody and harmonizations authored by Heinz Malina, Austria.
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near.
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Text, melody and harmonizations authored by Dennis Gersten, M. D.
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Key of E-flat

BABA,  BABA,  OM  SAI  BABA



G

Swa -
He

mi's
has

hap -
brought

py
the

ev -
world

'ry -
some

day.
light,

CM7

Still
Taught

we
the

just
peo -

can't
ple

help
wrong

but
from

say,
right,

G

That
His

this
de -

is
vo -

a
tee's

spe -
still

cial
al -

day,
right,

D7

Ba -
Ba -

C

ba
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Birth -
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Come on and
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sing it loud and
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clear,

C G

Text and music authored by Jesse Vance Boden, USA.

1.
2.

Sing both verses before going to next section.

BABA  BIRTHDAY  (Page 1)



Em

Loud e -

C

nough for the Lord to

G

hear.

C G

Em

Raise your

C

voice and beat the

G

drum.

C G
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Let 'em
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hear you clear to Pra -
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shan - ti Ni -

Em

la -

G

yam.

D D.C. al Fine
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Text and music authored by Jesse Vance Boden, USA.
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2.

Sing both verses before going to next section.
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G

yam.

D D.C. al Fine
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Text authored by Jay Jarrett of Atlanta, Georgia, USA.
Melody: Choral Finale, Beethoven's Symphony No. 9.

1.
2.

Sung in Unision
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1.
2.
3.
4.
5.

Melody and text created by Rosemary Bralley of Atlanta, Georgia, USA.
Harmonizations submitted by transcriber.
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Melody and text authored by Rosemary Bralley of Atlanta, Georgia, USA.
Harmonizations submitted by transcriber.
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Ba - ba shed your light on me,

shine a path for

1

me to see.

2

me to see.

3

On - ly

3

You,

3

on - ly

3

You,

Ba- ba, on - ly

1

You.

2

You.

Ba - ba sing Your song to me,

strong and clear so

1

I may hear

2

I may hear

Melody and text authored by Diane Justice, Atlanta, Georgia, USA.
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3

On - ly

3

You,

3

on - ly

3

You,

Ba - ba, on - ly You.

When the world spins all a- round me and I'm feel - ing so con- fused.

Help me al-ways to re - mem-ber that there is on- ly You.

3

On - ly

3

You,

3

on - ly

3

You,

Ba-ba, on - ly

1

You.

2

You.
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me
I

to
may

see.
hear

C
2

Gm7

me
I

to
may

see.
hear

C

C7 3

On -
On -

ly
ly

F

You,
You,

F7 B C7 3

on -
on -

ly
ly

F

You,
You,

Am7 5

B

Ba -
Ba -

ba,
ba,

C7

on -
on -

ly
ly

1
F

You.
You.

2
D.C.F

You.
You.

3
F

You.

Dm

When the

B

world

Gm7

spins

C

all a-

F

round me

Dm

and I'm

B

feel-

Gm7

ing

C7

so con-fused.

F

Dm

Help me

B

al-

Gm7

ways

C7

to re -

F

mem-ber

Dm

that

B

there is

Gm7

on- ly You.

C

C7 3

On - ly

F

You,

F7 B C7 3

on - ly

F

You,

Am7 5

B Gm7

Ba-ba,

C7

on - ly

1
F

You.

2
F

You.

Sing 2nd verse. Take 3rd ending. Go to next section.

1.
2.

Melody and text authored by Diane Justice, Atlanta, Georgia, USA.
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C

Let me be Your in - stru- ment,

Dm

Ba - ba, show me how.

C

Lead me where I'm meant to be,

1
Dm

Ba - ba, show me how.

2
Dm

Ba - ba, show me how.

The

F

faith in You makes me live, makes me love, and

F

want to be, a

1 C

bet- ter hu- man being.

2
C

bet- ter hu- man being.

C

When I fail, I know You're watch - ing me,

Dm

Ba - ba, show me how.

C

How to love, with- out ex - pect - ing things,

1Dm

Ba - ba, show me how.

2 Dm

Ba - ba, show me how.

C

Let me be Your in - stru- ment,

Dm

Ba- ba, show me how. Ba - ba, show me

C

how.

Verse 1

Verse 2

Chorus

Coda

(Sing Chorus than go to Coda)

(Sing Chorus after each Verse. Sing Coda after Chorus of Verse 2.)

Text and music authored by Tally Koren, London, UK.
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Let me be Your in - stru - ment,

Ba - ba, show me how.

Lead me where I'm meant to be,

1

Ba - ba, show me how.

2

Ba - ba, show me how.

The faith in You makes me live, makes me love, and

want to be, a

1

bet- ter hu- man being.

2

bet- ter hu- man being.

Verse 1

Chorus (Sing Chorus after each Verse. Sing Coda after Chorus of Verse 2.)

Text and music authored by Tally Koren, London, UK.
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When I fail, I know You're watch - ing me,

Ba - ba, show me how.

How to love, with- out ex - pect - ing things,

1

Ba - ba, show me how.

2

Ba - ba, show me how.

Let me be Your in - stru-ment,

Ba - ba, show me how. Ba - ba, show me how.

Verse 2

Coda

(Sing Chorus than go to Coda)
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& # c .. ...œ jœ ˙
G

Jai Sai Ram

.œ jœ ˙
Em

Jai Sai Ram

œ œ œ œ
C

Jai Sai Ba - ba

œ œ œ œ
D

Jai Sai Ba - ba

& # .. ..˙ ˙
G

Ba - ba

˙ ˙
Em

Ba - ba

œ œ œ œ
C

we ad - ore You

œ œ œ œ
D7

we - love You

BABA, WE ADORE YOU
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Introduction
D G A D D G A D

Women

Men5

Ba - ba we a -

5 D G

Ba - ba we a -

dore You,

A D

dore You,

Lay our lives be -

D G

Lay our lives be -

fore You,

A D

fore You,

Women

Men
9

How we

9 D G

How we

Love You,

A D

Love You,

D G

Ba - ba we a -

A D

dore You,

Women

Men
13

Ba - ba we a -

13 D G

Lay our lives be -

dore You,

A D

fore You,

Lay our lives be -

D G

How we

fore You,

A D

Love You,

BABA,  WE  ADORE  YOU (a round)
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Key of D 

{Melody- lower  notes (Stems down); Descant - upper notes (stems up)}

As sung by the Journey to Sai Through SAI Pilgrims.    



Women

Men
17

How we

17 D G

Ba - ba we a -

Love You,

A D

dore You,

Ba - ba we a -

D G

Lay our lives be -

dore You,

A D

fore You,

Women

Men
21

Lay our lives be -

21 D G

How we

fore You,

A D

Love You,

How we

D G

How we

Women

Men
24

Love You,

24 A D

Love You,

How we

D G

How we

Love You,

A D

Love You,

BABA,  WE  ADORE  YOU        p.2

Sung Slowly



D G A D D G A D

5

Ba - ba we a -

5 D G

Ba - ba we a -

5

5

dore You,

A D

dore You,

Lay our lives be -

D G

Lay our lives be -

fore You,

A D

fore You,

9

How we

9 D G

How we

9

9

Love You,

A D

Love You,

D G

Ba - ba we a -

A D

dore You,

BABA,  WE  ADORE  YOU (a round)Key of D 

{Melody- lower  notes (Stems down); Descant - upper notes (stems up)}

As sung by the Journey to Sai Through SAI Pilgrims.    

(Men)

(Women)

(Women)

(Men)



13

Ba - ba we a -

13 D G

Lay our lives be -

13

13

dore You,

A D

fore You,

Lay our lives be -

D G

How we

fore You,

A D

Love You,

17

How we

17 D G

Ba - ba we a -

17

17

Love You,

A D

dore You,

Ba - ba we a -

D G

Lay our lives be -

dore You,

A D

fore You,

BABA,  WE  ADORE  YOU                   p.2

(Women)

(Women)

(Men)

(Men)



21

Lay our lives be -

21 D G

How we

21

21

fore You,

A D

Love You,

How we

D G

How we

24

Love You,

24 A D

Love You,

24

24

How we

D G

How we

Love You,

A D

Love You,

BABA,  WE  ADORE  YOU                   p.3
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& # 44 .. ..œ œ œ œ
Em

Om, Sai Ba - ba

˙ œ œ
B7

Jai. Om, Sai

œ œ ˙
Em

Ba - ba Jai.

& # .. .. 45œ œ œ œ
D

You are end - less.

œ œ œ œG

You are bound - less.

œ œ œ œ
B7

You are ev - 'ry -

w
Em

where.

& # 45 .. 44jœ jœ ‰ œ jœ jœ jœ œ
Am

You are liv - ing in my heart.

jœ jœ ‰ œ jœ jœ jœ œ
Em

I am liv - ing in Your bliss.

& # 44 ..1œ œ œ œ
D7

So, we live to -

˙ ˙
Em B

geth - er.

2œ œ œ œ
D7

So, we live to -

˙ ˙B

geth - er.

& # .. ..œ œ œ œ
Em

Om, Sai Ba - ba

˙ œ œ
B

Jai. Om, Sai

œ œ ˙
Em

Ba - ba Jai.

& # .. ..œ œ œ œ
D

You are end - less.

œ œ œ œG

You are bound - less.

œ œ œ œ
B

You are ev - 'ry -

w
Em

where.

BABA,  YOU  ARE  EV'RYWHERE
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care
joy
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&10 Jœ œ JœC

1.Call -
2.Shar -
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Jœ œ .œ
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.œ Jœ Jœ Jœ
close
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to
sound

your
of

Jœ œ .œG

form
God,

.œ Jœ Jœ Jœ
with sing -

show -
ing
er -
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ing

&15 Jœ œ .œ
Name,
Love

.œ Jœ Jœ Jœ
 

all
Prais -

o -
ing

ver
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.œ .œC

me
Lord

1..œ
.

2.œ Jœ
. 2.Re -

&20 Jœ Jœ Jœ
Let -
mem -

ing
ber

me
these

.œ .œ
know
times

œ Jœ Jœ Jœ
,

I
when

am
you're

Re -
a -

.œ œF

born
way

œ Jœ Jœ Jœ
to

Get -
sing

ting
from

to
your

&25 Jœ œ .œG

feel
heart

œ Jœ Jœ Jœ Jœ
 

the
I

mus -
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ic

Di -
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.œ .œC

vine
Love

.œ Œ .
.
.

BEFORE I LEAVE
Words and Music ©1995 Ulla Dürnfelder

©1995 Ulla Dürnfelder
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& c jœ
Be -

œ œ œ œ
C

gin the day with

˙ œ ŒG7

love.

œ œ œ œC

spend the day with

˙ œ ŒG7

love.

& .˙ œC

End the

œ œ œ œ
G7

day with
w
C

lo

œ œ œ œ
G7

ve, that is the

& .œ jœ œ œC

way to God, that

œ œ œ œG7

is the way to

œ œ œ œC

God, that is the

.œ jœ œ ŒG7

way to God.

& .˙ œC

A

œ œ ˙
G7

w
C

men.

Ó Œ ‰G7

BEGIN THE DAY WITH LOVE
Text by Sathya Sai Baba, melody and harmonizations by Matthias Hellermund, Germany
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Round 4 to 8 voices

D.C.

1) 2)

3) 4)

5) 6)

7) 8)



Be with me wak - ing and sleep - ing.

While I am work - ing. When I am dream - ing.

I place my heart in your keep - ing.

Om Bha - ga - van, Om Sa - i Ram.

You are my Teach - er, You are my Lord.

Al - ways re - spect - ed, ev - er a - dored.

I am so thank - ful that You are mine.

Moth - er Pro - tec - tor, Fath - er Di - vine.

Text, melody and harmonizations authored by Jesse Vance Boden, USA.
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E

Be with me

B 7

wak- ing and

A

sleep -

E

ing.

B 7

While I am work - ing.

E

When I am dream - ing.

E

I place my

B 7

heart in your

A

keep -

E

ing.

Fm

Om

B 7

Bha - ga -

Cm

van,

Fm

Om

B 7

Sa - i

Cm

Ram.

A

You are my Teach - er,

E

You are my Lord.

B

Al - ways re -

B 7

spect - ed,

E

ev - er a- dored.

A

I am so thank - ful

E

that You are mine.

Fm

Moth - er Pro - tec - tor,

G

Fath - er Di - vine.
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Bha - ga- van, take our love, let it flow to Thee.

Take our hands, let them do Thy work con - stant - ly.

Take our souls, let them merge with Thy Ho - ly Light.

Take our minds, make them pure, per - fect in Thy Sight.

May our thoughts, born of Thee, guid - ed from a - bove,

Make us all, Bha - ga- van, in - stru- ments of Love.

In - stru - ments of Love,

Melody: Anthon Dvorak's 'NEW WORLD' SYMPHONY Text authored by Jay Jarrett, Atlanta, Georgia, USA
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C

Bha - ga-

G7

van,

C

take our love,

Dm

let it

Dm7

flow to

G7

Thee.

C

Take our

G

hands,

E7

let them

Am

do

Dm

Thy work

G7

con - stant -

C

ly.

F

Take our souls,

Em

let them

F

merge

F

with Thy

Em

Ho - ly

F

Light.

F

Take our minds,

Em

makethem

Dm

pure,

F

per - fect

Em

in Thy

F

Sight.

C

May our

G7

thoughts,

C

born of

Am

Thee,

Dm

guid - ed

Dm7

from a -

G7

bove,

C

Make us

G

all,

Am

Bha - ga-

Em

van,

Dm

in - stru-ments of

C Am

Love.

Dm

In -

C

stru-

Dm

ments

Bm7 5

of

C

Love,

Melody: Anthon Dvorak's 'NEW WORLD' SYMPHONY Text authored by Jay Jarrett, Atlanta, Georgia, USA
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An -
Bow

tar
to the

Jyo -
light

thi
with -

Na - mo
in,

Pa-
to

ram -
the

at -
om -

ma
ni -

Jyo -
pres- ent

thi
light

Na -
of

mo
God.

Repeat twice

A -
Bow

khan -
to

da
the

Jyo -
end -

thi
less

Na - mo
light,

Ma -
the

ma

Jee -
light

va -
that

na
is

Jyo -
my

thi
ver -

Na -
y

mo
life.

Repeat twice

An -
Bow

tar -
to the

ya -
in -

mi
dwell -

Na -
ing

mo
Lord,

Jai
our

Sad -
true

gu -
Gu -

ru
ru

Sa -
Sri

i
Sath-

Na -
ya

mo
Sa -

Repeat twice

i.

ANTAR - inner

JYOTHI - Light

NAMO - bow to

PARAMATMA -
the Supreme
Soul

AKHANDA -
endless

MAMA - my

JIVANA - life

ANTARYAMI -
the Inner God
residing in
all beings

SADGURU -
the true,
good
Teacher

Melody transcribed from the recording: LEARNING BHAJANS.
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life.
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Bow
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mo
Lord,
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Jai
our

D

Sad -
true

A7

gu -
Gu -

ru
ru

D7

Sa -
Sri

i
Sath-

Na -
ya

G

mo
Sa -

Repeat twice

i.

ANTAR - inner

JYOTHI - Light

NAMO - bow to

PARAMATMA -
the Supreme
Soul

AKHANDA -
endless

MAMA - my

JIVANA - life

ANTARYAMI -
the Inner God
residing in
all beings

SADGURU -
the true,
good
Teacher
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